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After completion of Higher Secondary (+2) Vocational Engineering (EE) course, students
can pursue the following courses / Jobs / Self-employment as detailed below:

Vocational Stream

The Vocational Engineering students are blessed with two major opportunities after

completing their +2.

Educational Guidance Job Opportunities

BBA in Management

B.Com. Office Management
B.Sc Management

BA Management

B.Com Corporate Secretaryship
B.Com E-Commerce

B.A. (Vocational Studies) Office Management &
Secretarial Practice

Diploma in Modern Office Management

Diploma in Modern Office Management and
Secretarial Practices

Diploma in Modern Office Practices

Diploma in Modern Office Management and
Computer Application Engineering

Diploma in Modern Office Management and
Secretarial Practices

ACS — Secretary Course

Certificate course in Management

Assistant to Company Secretary
Member in Company Secretary Team
Assistant to Executives in Office
Executive Assistant

Administration Executive

Front Desk Executive

Office Administrator

Company Secretary
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1. Whatever you are, be a good one.
2. Be the change you wish to see in the world.
3. Try and fail, but never fail to try.
4. Choose death rather than dishonor.
5. Believe you can and you’re halfway through.
6. A false friend is worse than a bitter enemy.
7. To travel is to take a journey into yourself.
8. I haven’t been everywhere, but it’s on my favorite list.
9. Brief words are best on burning matters.
10. June has put a spirit of youth in everything.
11. Lie down and listen to the crabgrass grow.
12. The earth laughs in flowers.
® 13.  Water is the most precious force of all nature. ®
14. Human beings, must go back to nature for information.

15. Music should strike fire from the heart of human.

2181) Geus LWIDF QFILIWIOYD.
1. Hear twice before you speak once.
2. True friendship is a plant of slow growth.
3. I never think of the future it comes soon enough.
4. Hasty resolution seldom speeds well.
5. A poem begins in delight and ends in wisdom.
6. Fear of God is the beginning of wisdom.
7. Long ago I bought a dry gold necklace.
8. Krishna got 2/5 and Varsha 3/5 of their shares.
9. Received 5 sets Table(2’6”) & Chairs (1°6”).

10. Pack my box with five dozen juice mugs.
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3p) &Gl a&MbeSLILL(beTer dm uSHEemeT Lbha (Wwewm LuInHd aFiiweyD.
(2p2) (Amy) uSHBeWET WHEI (PEOD GEUCIEUTETMID

1. Tracy looked at the flag. The flag is red, white, and blue. It has fifty white stars, seven
red stripes, and six white stripes.

2. Donald plays the piano. He loves the piano. He has a big piano in his living room.
His piano is shiny and black. It has three legs and a bench.

3. 'This weekend I went to the zoo. It was great. I went with my mom and dad. My sister
came, too. The zoo was in the city. The zoo was very long.

4.  When I was playing today at recess, I felt like a kite blown around by the wind. It
was hard to stay in one place because the wind was so strong.

5. My teacher is awesome. I think she deserves an award for teaching. I have liked all
my teachers, but she is by far the best I've ever had.

(88) (aup&HsLomeT) LUSHem Db (PO SHLLEFS QFILIS LLPSHEYD (66)E6UTEITeNDIILD)

1. IndiaisaDEMOCRATICSOCIALIST countryin the World. Infect, DEMOCRATIC
SOCIALISM has been offered as a solution to the DEVELOPMENTAL
resolution which India has undertakes to break through the barrier of UNDER-
DEVELOPMENT of carrying forward the liberation of many millions of people

@ and pushing through the DEVELOPMENT in all spheres of life. The SOCIALIST @

transformation which India aspires is that of building an independent, economy
and comprehensive, including agriculture, on a modern technical basis as early
as possible.

“India is my Country. All INDIANS are my Brothers & Sisters. I love my
country and I am proud of its rich and varied heritage. I shall always strive
to be worth of it.

I shall give respect my parents, teachers and all elders and treat everyone
with courtesy. To my Country and My People, I pledge my Devotion. In their

well-being and prosperity alone lies my happiness”.

2. The question here is, are all of them entrepreneurs? The answer is both yes and
no. If we say that an entrepreneur is a person, then all the above individuals are
entrepreneurs. When we add that a person having his own business only is an
entrepreneur, excepting Kamath and Prabhudeva, all the others are persons having
their own business — small, very small, or large. But we say that an entrepreneur is a
person who starts his own business. Chandrasekaran and Narayanan are taking care
of the business started by their father; so they are not entrepreneurs. Ramu, whose
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mother prepares sundal and asks him to go to beach, sell and bring the money and
give it to her, is also not an entrepreneur, but only an employee. Also, if shops and
businesses are not started by them, then they also cannot be called entrepreneurs.

FLLES uWind — unaid Il

1. Gauasliuind — Sp au@Hbd s echenTenw LHenerhgl HISLSHHl6 HLL &8 OFLS
(PI.EHSHYLD.

a1) The present constitution of India was framed by the Constitution Assembly of India set
up under the Cabinet Mission Plan of May16, 1946. The idea of establishing a Constituent
Assembly to draw up the Indian Constitution was not a new one. The American Constitution
was framed by a Constitution Assembly. In fact, American Constitution has proved to be
a model to the democratic world. Till independence, India was governed under the Acts
passed by the British Parliament. In 1938 Sri Jawaharlal Lal Nehru declared: “The Indian
National Congress stands for independence and a democratic state. It has proposed that
the constitution of free India must be framed, without outside interference, by a constituent
assembly elected on the basis of adult franchise. That is the democratic way and there is no
other way short of revolution, which can bring the needed result. An assembly so elected will
represent the people as a whole and will be far more interested in the economic and social
problems of the masses than in the petty communal issues which affect small groups . ”

® The inaugural meeting of the Constituent Assembly of India was held on December ®
9,1946. It was presided over by Dr.Sachchidananda Sinha who was the oldest member of
the Assembly. On December 11, 1946, Dr. Rajendra Prasad was elected President of the
Constituent Assembly.

On December 13, 1946, Shri Jawahar Lal Nehru moved the “objectives resolution” which
later became the Preamble of the Constitution.

A number of committees submitted reports to the Constituent Assembly on the different
aspects of the constitution. On the basis of these reports the constitution was prepared by
Constitutional Adviser, Sri B. N. Rao. The Drafting Committee under the chairmanship of
Dr.Ambedkar worked on the draft and produced the Draft Constitution with 315 articles
and 8 schedules. The Draft Constitution was considered by the Constituent Assembly. In
its progress through the Constituent Assembly, the constitution grew in bulk and took its
final shape with 395 articles and 8 schedules. The time taken in accomplishing this task
was exactly two years, eleven months and 17 days from the first meeting of Constituent
Assembly on 9™ December, 1946 till November 26, 1949 when “We, the people of India”
gave unto ourselves the new constitution.

There have been over 92 amendments to our Constitution so far.
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Procedure of Amendment

The Indian Constitution is a combination of rigidity and flexibility. It has neither the rigidity
of the American Constitution nor the flexibility of the British Constitution. Three different
methods of amendment have been provided under the Indian Constitution.

First, certain provisions of the constitution can be amended by Parliament by ordinary
legislation. For example, Parliament may, by ordinary law (i.e., a law passed by a simple majority)
form a new State out of the existing States, increase or decrease the area of any state, alter
the name of any State, etc. Again, for abolition or creation of Legislative Councils in States,
Parliament may, by ordinary law, provide for this, provided the Legislative Assembly of the State
concerned passes a resolution to that effect by a majority of the total membership and at least
a two-thirds majority of the members present and voting before Parliament undertakes to pass
such a law.

Secondly, certain specified provisions can be amended by a special procedure.

&) In case of the aforesaid order having been made any of the following persons shall be
required to preserve and produce all the books, registers, other documents and records of
and relating to the company/intermediary/other person being in its custody or power: (i)
every manager, managing director, officer and other employee of the company ; (ii) every
intermediary referred to in Section 12; (iii) every person associated with the securities
market. The investigating Authority may also examine any of the aforesaid persons on

@ oath. Further, Investigating Authority may also examine any of the aforesaid persons on @

oath.

Further, investigating Authority may call for information, books, registers or other
documents and records which it considers relevant and necessary for the purpose of its
investigation. It may keep the records produced before it in its custody upto 6 months. It
may issue certified copies of those documents for use of the person on whose behalf the
books and documents have been kept. In case any person referred to above refuses to or
fails to furnish the desired books/records/information or refuses or fails to appear or sign
the notes of any examination, he shall be punishable with imprisonment for a term which
may extend to one year, or with fine, which may extend to one crore rupees, or with both,
and also with a further fine which may extend to five lakh rupees for every day after the
first during which the failure or refusal continues.

Investigating Authority has also been empowered to secure an order for seizure of
books, registers, other documents and record by making an application to the Judicial
Magistrate. Such an application can be made where in the course of investigation, the
investigating Authority has reasonable ground to believe that the books, registers, other
documents and records of, or relating to, any intermediary or any person associated with
securities market in any manner, may be destroyed, mutilated, altered, falsified or secreted.
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After considering the application and hearing the Investigating Authority, if necessary,
the Magistrate may, by order, authorize the Investigating Authority- (a) to enter, with
such assistance, as may be required, the place or places where such books, registers, other
documents and record are kept; (b) to search that place or those places in the manner
specified in the order; and (c) to seize books, registers, other documents and record it
considers necessary for the purpose of the investigation.

However, in case of a company intended to get its securities listed on any recognized
stock exchange, order shall be passed only if such company indulges in insider trading or market
manipulation. Further, records seized must be returned back to the company/body corporate
after the conclusion of the investigation. Search and seizure, as aforesaid, shall be carried out in
accordance with the provisions of the Cr.P.C. 1973 relating to searches or seizures made under
the Code.
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w/ with (something)
w/o without
w/i within
ie. that is

® e.g. for example ®
etc et cetera, so forth
bc because
b4 before
re: regarding, about
esp especially
min minimum
max maximum
govt government
ASAP as soon as possible
wrt write
rt right
yr / yrs year, years
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C. circa, about, around, from the year
Vs versus, as opposed to
I ch chapter
Q A question answer
ex example
wd  wds word words
ref reference
diff difference

SIS GO (1) Fl6UrhiGLD (Y6OT 2_6iTerT (P19 6UEML LD 6UMT HemSHulled &i(Th&eLD

euny Hemsulledr & (H&eLD: SIM)Hev:
@ B pol - politics B govt — government ®
B gov - government B govt - government
B subj - subject B interl — international
B info - information B inter'| — international
B intro - introduction
2_uiarpsems Unsemnflsse ing emw Y& 6ol 5ed:
B prbim - problem B ckg - checking
B schl - school B ckng - checking
B  bkgd — background B ckg - checking
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(a)

(b)

(c)

(d)

(e)

GuaGLésamrd HDhHs SPEHGETITL eT6YHEBLET Frlgll QI LS HpeUTITSHmS
©_(HEUMTSHSHEYLD.

Uss Sleney — A4
U MhiGerfleoT ereooreotflbemnd — 4

Ged LSS D 1.25 SMIGEOLD HM LUSSHISET 0.75 SihiEe0LD

Sp&HSHET0TL. 2_emIemll 2_6ierfIL 6.
HAPPINESS

Happiness is often confused with fun, good living, and riches. Sometimes fun is equated
with happiness. Fun is what we experience while doing an activity, whereas happiness is
a residual and long-lasting feeling. The path to happiness is long and full of challenges.
Happiness requires life—-long pursuit.

HAPPINESS eretTeiid semeoliling er(p58 euemauieor sieney 18 yeraflear, er(pssl
euema Arial, $191060T, MW BewFE)] JPEW QUQELL L OHEDETE OFIS.

USHES SPSHSHEITL 6UIE)L L EOSHEN6TE C1FILIS.

(a) Font - Arial
(b) Font size - 12

(c) Alignment — Justified

(d) Leading - 20

S} 6LETTT HEMS 'happiness' eTeoTn GLwWifled GFL&HS.
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2. ulgiulemnLuiled File > New erettLemss Slafles asiweyn. (sieveog) Ctrl + N eredrenid
eflemsliLenems GSMNIGS auflemwill LweTLI(bSSeYD. & Document Setup 2_emmwimLed
QULIgemWS SHMEBEGSLD.

Document Setup 0K
Page size: ILetler El Cancel

Dimensions: |85 x 1 inches

Orientation: ©© Tal " Wide (b |

Options: ¥ Double-sided I™ 2djustlayout
I¥ Facingpages [ Restart page numbering
Number of pages: |[| Start page #: |1
Margins
Inside: |1 inches Outside: ]0.?5 inches

Top: |0.75 inches Bottom: |0.75 inches

T arget output resolution: |3£IU vl dpi

Compose to printer: I?DISPLAY on Mone :I

B Page Size SYlnig ulleuliquied Hefls aFig A4 eTeTad LSS leTen6US

CaliheSheHsaLD.
® B Number of pages 2_emrleLLiquied 4 ereor 2 _aTerflLeyw. ®
B gurhsefler Siememel &Lp&se00TL 6D LOMHMEYLD.
Inside — 0.75 inches
Outside - 0.75 inches
Top - 1.25 inches
Bottom — 0.75 inches
Document Setup 0K

Page size: |44 x| Cancel
Dimensions: [6268  # [11693  inches —————
Orientation: ©* Tall  Wide
Options: [ Double-sided I~ Adust layout
[V Facingpages | Restart page numbering

Number of pages: |4_ Start page #: |1_
Marging

Inside: |.75 inches Outside: I.?S inches
Top: I'I.25 inches Bottom: |.75 inches

Numbers...

Target output resolution: IBOU vl dpi

Compose to printer; I?DISPLAY on None L]
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yslw speuevord flemguied CamedTmid.

o

Fie Edit Layout Type Element Utlites WView Window Help

ST Y N S 2 T S | ER N S T e I el A N T KT e

Bl Untitled-2

Syles ™| Colors l'|h||
e 1007 <] Jud™
B [Mone) =

v X

#[12344in |
Y003 in |

L
-

4. 6L&6VL themend Hefle QFILE QI 2 mISSTGHemW 2 [Heurssayb. Ing &6
QBM(bSBLILL(H6TEN _emIemll HLL & GIFIILIEYLD.

HAPPINESS

Happiness is often confused with fun, good living, and riches. Sometimes fun is equated
with happiness. Fun is what we experience while doing an activity, whereas happiness is
a residual and long-lasting feeling. The path to happiness is long and full of challenges.
Happiness requires life—long pursuit.
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5. GIL&EIL ChemeDdH C\&HTE00T(h 'HAPPINESS' eTeoTUEmS S BHIHOSHBb&&D. Character Control
Palette ceold 61058 6uems Arial, 1S5 euemsuletr aiemey 18 Lererflser, Leading 22
eTeoT LOMHMEYLD. Bold eungsnementd Heafled Fwweyo. UIn@ emwow Qemgaing Shift +
Ctrl + C eretreniid smefl G&ionenrHems SH(QSSHELD.

£ adobe PageMaler 7.0 - [Unbitled-2] = =10 %]
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cpeld 1RSI euemd Arial, er(pss euemsulet siemey 12 yeTeflser, Leading 20 ereor
wrppeyw. Une Criss ensalng Shift + Ctrl + J areotenib smefl G&IOMEOTSHemS

S(R5SELD.
£ Adobe PagelMaker 7.0 - [Untitled-2] N =10 x|
[ File Edit Layout Type Element Utiities View Window Help =18 x|
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7. SH6UETUIHNS 'happiness' eTeoTn GlLwifled GaL&Hs
eflemsLiLeemauiled Ctrl + S eTedTLemS Si(RSHSED Seveod UL lqliL emLuied File > Save
eTeoTLIEMSS Hlerflée aFliwieyb. Save publication 2_emguwimed euLly Gsmeormid. File name
2 _emrlieILLiquied 'happiness' 6Te0T HLL &S 615G Save aunsSmenerd Hlafls QFieyD.

x
Saveinzl | My Documents ﬂ = ¥ B3~
Name - | L' Date modified | 'lil
. Adobe 1/13/2019 10:06 AM
, Corel 1/13/2019 10:28 AM
, Custom Office Templates 1/23/2019 9:26 PM
, CyberLink 1/13/2019 10:34 AM
, eBook Converter 1/13/2019 1:00 PM
. Inventor Server for AutoCAD 2019 2/3/2019 6:36 PM =
«| | »
File name: Ihappiness Save
Save as type: |Publication 4 :] Cancel
Copy:
* No additional files
@ " Files required for remote printing @
€ Allinked files
aeuerfluic
HAPPINESS

Happiness is often confused with fun, good living, and riches. Sometimes fun is
equated with happiness. Fun is what we experience while doing an activity, whereas
happiness is a residual and long-lasting feeling. The path to happiness is long and

full of challenges. Happiness requires life-long pursuit.
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Student Notice Board

BCuBwsasemTLll LweTUbSS meooteul SiMledllyl LDenSHemU 2_([HEUTHEIH6D.
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1. Start > All Programs > Adobe > PageMaker 7.0 > Adobe PageMaker 7.0
areorm auflemsuied &lefls &S B LS CURCLEST HEUETTSHMSS SMESHELD.

2. ulliulenLuied File > New erettuenss Hafle agwe)b. (siedeogl) Ctrl + N ereotemid
eflemsliLenems GSMIHS eUdlemILl LWeTLbSSeD. & Document Setup 2_emrwimLed
QuULIgemwd HnHGSLD.

3. OK eungsnemen &Hafle egiwen. @ueung Untitted — 1 eteorm euwirfled y&Hlu
Sp6uetord FHlewruied GHmedTmiLd.

4. OISLMMEISHED themeDLl LweTUbSEH 100 mm X 100 mm Siemey6Tel 6ILILIG eI 6UEmITL
Geuetorhld. iFled fwimedr (Cyan) Bmdemg Hrlueyn. tint wHlenu 25 Faeigwons
rHoeyd. Sueunes ULl Spéseesoreurm GemedTmi.
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5. 8CsGunmeirmy 100 MM x 15 mMm SiemeyeTen LMHEDTIH GILLLGemUI euemTl GEUeTr(hiD.

® afev &Ly (black) Bmdemg MHirliueyo. @nal eulgenw dwmer (Cyan) Hmo ®

Briuiuce auliguies Goebu@GHuled emeudbseayb. BUaum (gl ULl Sp&asetorLeumm)
GamedTmILD.
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6. 6IL&6L themedd &(HLIL HIDL UL Iquier SL & @IsHHelmha 6uens @I euemr Heafls

651 8158 GeueturpiD. LeoTeur Sigled " Student Notice Board" 6T60TM)| SLL &S QFILI
BeuevoT(hLD.
eT(RSSle0r B QUL Iquiledt EIM(PLD Q60T (SBLILINS) S(HHSLD. 2_mIeml SLL &5
Q&g (Pysse|Ler Ctrl + A ereitend ellemsliLDens GMNIHS Ul CLOEOLD 2_emTemil
GaHOSheESLD.
Character Control palette cpeold er(psdlenT siememen 20 Leaflsemms wmpmeyn. Bold
uettfls@nlemws Hefld aFweyD. Reverse eunggnemensd Heafld OFLFHTED 2 _6mI
GleueTemean HMLONS WMMID. 2 _emremwl enwl @ewse| asiw Shift + Ctrl + C eretremid
aflemslILOems GMNIGHS Ul LWETUbSSHED. @reunes wrssoreul SipleiL
Leens EpsaetorLeunm Hemmuled GHmedTmiLb.

eeuefluicy

Student Notice Board

w6y
THIUMTSSILULL (P96 HeDLSHSE.
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CuiBwssl — el 0 5
SMNTML 2 _(H6UTSHEHSHED

eleorm
GugBwssemIll LWETUbSH SpésHetorL efdliqnm SNTenL 2 (HeUTHE.

S. Barath Kumar

Vision TECH

S, Annai Avenue, Trichy - 17
Ph : 0431 - 2780000

BGuhBwsHasemIL LW6TUbSS 61BMbeSULL(beTen L nk SMTenL 2 _(HeUTHESSH6D.

aglilemm
1. Start > All Programs > Adobe > PageMaker 7.0 > Adobe PageMaker 7.0 eredim
auflemsuied Heafles aFLg @ UHw CURCLEST eUaTTHMSS SMHSED. UL SHH 0
srliqujerereurm] SGLML CuiCasT georteored Hlewr GHmedTmiLD.
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2. ulliuenLuiled File > New eredtLemaé SHleflé a&lweyd. (Siebeog) Ctrl + N eredtemd
eflemsliLenems GSNIGS auflemwlll LweTLI(bSSeD. &% Document Setup 2_emmwimLed

QULIgemWS SHMEBGSLID.

Document Setup 0K I

Page size: |Letter ;l Cancel

Dimensions: [85 [11 inches
Orientation: © Tall © Wide
Options: [V Double-sided [~ Adjust lapou

[V Facingpages | Restart page numbering

Number of pages: Start page #: [1

Margins

Inside: |1 inches Qutside: {0.75 inches

Top: |0.75 inches Bottom: {0.75 inches

Numbers...

Target output resolution:  [300 v dpi
Compose to printer: I?DISPLAYonNone ;I
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3. OK eunggmemeor ferfls aFiwieyd. LULSH6d srliqulstareurm) Untitied — 1 eredrm eLwirfled
yslw speuevord flemguied CamedTmid.

£ Adobe PageMaker 7.0 - [Untitied-1] =lofx=

[F] Fle Edt Leyout Type Element Ubies Vew Window Help =12 x|
MEEEOREEEE R EEE RN PR O EEEEE

T P T T T T o, oo P, T o PO oo PO, P T Pt V. M
El=|

3

=D

(=

[HA]E

3 [E32(=

2 ole

Jele

= EES

E |
¥

2

; [ = |

2 &
P ol 1 s

4. @ueunpg sersibaener Inches edlbg Milimetersé@ omHmeyLD.

uLigliuemLuied File > Preferences > general eredth &L Lemenemwld lerflé O1FWWLIGYLD.
(s1eve0g) elemaliueensuied Ctrl + K erettLems sipssen. @ueurngg Preferences
2 _emIWIML6d QUL GsHmedrmLb.

aifled Measurements wpmid Vertical ruler S¥iprig ulleuliquisd Milimeters
eTeTUEmS S BHITHOSH(bSH&SHEYLD.

x
0K I

Vettical uler: [Milimeters | | points Cancel

Measurements in: M limeters

Layout problems: |~ Show loose/tight lines
I~ Show "keeps" violations

Graphics display: ¢ Gray out
¢ Standard CMS setup...
" High resolution

More...

Map fonts...

-~ Control palette Save option: ¢ Faster
Horizontal nudge: |1 IMiIIimeters El " Smaller
Vertical nudge: |1 IMiIIimetels El Gidss 1 | Fiont
™ Use "Snap to'" constraints " Back
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5. &l auULquiled[Hhg OTSLNTRISE thewend CHIHOSH(bSHE OFEUEUSLD UEDITUIOLD.
6. Control Palette &eb width 95 mm ereoteyd height 55 mm ereoTeyLD LOMHMEYLD.

o]
[{] Fle Edit Layout Type Element Ubities View Window Help ==
EEIEIEIF NN E I-lrlwi E[ElEn (B [Ha@eB|[®[S]m & ? ]
+IM|I|S||£|E||I|4| IE||I|'D]|I| L 1I|5| I|B||Ifu| |i|21I|HI| 6||IFB||I?D” Slulu Calars ¥ =
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£ AT [ liPaner] =
3 (2] Trsrgare R
3 Isell=
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mlEE
E o E
e fl| T [N
s =]
]
.LE i L]
& i
1] B
%
o]
® - ®
o]
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]
]
]
: Eleb R - EIE@'f'*‘l
Toullin % e
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7. &@medlauLiguiled 6l1L&6L. themed Slerflé FIWWIeYD. HLL &8 & Geustoriqul ©_emruileor
aTebemeDemWsH GSHILLL 6F6ueusHSHl60T BL & cemeouledBHhs 6UEDS CLOEDED EUHT
dafles asigH S(1p5&H6)D.

8. muifledr OUWemT 2_6iTerfl(h, SiIemS GIL&H6IVL. ehed cpeold B HImHedbaH&Ee. Control Palette
cpeold BHEMEUWITEDT 6T(IRHG! 6U6ME LOMHMID 6T(RSHSI60T SieTEWEUS \BM(b&HSELD. Ll60TEoTIT
6uen s LUmwns Anfle HeTSSeLD.

=loix]
[B] File Edit Layout Type Element Utlities View Window Help =|2] x|
[Di=[R[@[a] Al [v[ml[a [ E[=EER B[] [HlaM e[ B[®[e & ? |

i H g 10 1 1 1 13 2

| Stultra Bﬂhrsg 4
Tink: |I|:mc -I

5. Barath Kumar
K

Do "8

Ll il LIJ
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9. UgFlemed 7 & OMILIGUID QFLIWLIED. [Him|euetTSHHleor lLwemr 2 66l (h, HiemS G SH6vL
thed ceold BaIIHeGb&&He . Control Palette epeold GaHemeulLITeT 6T(1058 6UEMS LOMHMILD
TIPS SeMemEUSH QBN (HbSHSHEYD. LNe0TeTT 6uevd Umons SNlg HaTSHHeD. (PSHed
ET(R5HEMS 6IL&H6L ¢hed epevld BHIHOSHHSHSI 6T(RSH8I euenSHUetT SieTemer aLIflEHT&HSeLD.

i adobe PageMaker 7.0 - [Untithed-2]

&Edthmrmmwmmwmuﬂp

=12l
=18 x|

Dz RalalAlslc]vm)[ale

= ||I||I|IIII||III|IIIIIIIII|I|||||||I|||:|I|||.I|!I|ml|:||.ﬂ||||||||I|I|IIIIII
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5. Barath Kumar
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I;_?] = E|Ijﬂ|@|@|ﬁﬁ1]§| |

1=
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10. ugblemed 7 & WMUQUWD QFLWeD. Bimeuarsdlen (waeauflenw 2 erefllop, Siems
6IL&61VL ehed epeld BaiThHeBbe&a . Control Palette epeoid GsemeulLITeDT 61105 S 6U6M S
LOHMID 6TIRSHHE0T SHETEMEUS C1GHM(bHSED. Ll6TE0T eUend Lmns Arlg HeTSHSHeYLD.

i Adobe PageMaker 7.0 - [E:\PageMaker-High Resolution Images\Practical - 1pmd]

[[] Fle Edt Layout Type Bement Utiites View Window Hep

o]
lsix|
Hzfé HIALA‘| NG| ﬂlDiEIQ|‘-.—“||il|—":—‘.|B;|EE -i‘“"a@m
gintaiisbveeons il yesnoebisomnStesangstoncaes s i o S voriobvion el hssonisosoone s monsos bt 8ot v 1, 150
il L
[ Sl { Colors™, [P

T [100% -]

S. Barath Kumar -l
Vision TECH
- A.mi.—\re:-e, Trichy - 17
@
=
T o
eeuaflui
S. Barath Kumar
L ] L ]
Vision TECH
S, Annai Avenue, Trichy - 17
Ph : 0431 - 2780000
w6y
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0 6 BGukBwssl — @ Geollener
(Label) 2_meuns @&

eleoTm
BughBwdsenTll LwWeTLbSH EpdsetorL Geollemer (Label) o meunée.

- N

ame : (A A R R R R R R A R R R R R R R R R R R R R R R R R R R R )

SECLIOMN ¢ aoveererrrieneercesssccsssssccsssssssssssssssssssssssssssssssns

SChOO] : LR R R L R L R R R R A L R R R R R R R R R R ]

-
L]
S“bject L L LR R R R R R L R R R R R R R L R A A R R R R R R R R R R R R R Y

® \ J ®

BuiBdasemIll LWeTLbSSH asMbesIUL(baer Gelener (Label) o _meaund@se.

e F(emm

1. Start > All Programs > Adobe > PageMaker 7.0 > Adobe PageMaker 7.0  eredim
auflensuied Hefls &Lg B LSW CURCLEST HeUETTTSHMSS SMESHELD.

2. ulliulenLuied File > New ereotuemss Herfls asiweyn. (Sieveog) Ctrl + N ereoremid
eflemsliLenems GSMNIGS auflenwill LweTLbSSeD. && Document Setup 2_emTwimLed
QULIgemWS SMSHSLD.

3. OK eungsnenenr &Hefls eswen. @ueurgs Untitled — 1 ereorp euwifled LHlw
Sp6uetord FHlewruied GHmeoTmID.
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4. Yn@ enefipademen Inches edpb& Milimeters &@& onhHm Geuedor(hid.

ULl emLuied File > Preferences > general etedim &L Lemememwid dlerflé 1FWWLIGYLD.
(1eve0g) eflemasliLeoensulled Ctrl + K erettuems sipsseyn. @uewunpg Preferences
2 _emIuIMLed auLly GHmedrmi.

aifled Measurements wmmib Vertical ruler &¥lmrkig uliglieiuliquied Millimeters eredTLemS S
CaibHesbeHSaLD.

5. s@meNleULIGUiedBhHE QTSRS hewedd CHIHOSH(bSHGEH C1FEUEUSHD EUEMTUIOYLD.

6. Control Palette &eb width 100 mm ereoreyd height 40 mm eTeoTEYD LOMMHMEYLD.
7. ulglulenLuied Element > Rounded corners etettuemss Slerfle Q&ILIGYLD.
8

Rounded corners 2 emgwnLed 6QULIquielipihs GCHemeuwinesr 6l euSHmSHS
GaHegbh&HSa|D. SUOLN(IQE QI L (PN 6F6lausHD GHTeoTmID.

9. smellauluied eL&evL hemesds &efled Qsg, 6FSHESHDGET &
9_emISHOSTSGI MW ©_(HeUTHSHELD.

10. Name : erelTLUEmSS FHLL&F& Q5IG HIEOWE)] elemFeml SH(RSHHELD.
STD : eretTLEmSS FHLLEFS Q5ILIG HIEOWE)] elemFemil Si(RSHSELD.
Section : ereiTLMSS HL L 56 61FILIG HIEWLPE) 6XlemFMII SH(RSHHELD.
School : eTetTUMSS S L &8 615G HIEWLPE) ElenFenI Si(RSHSHEYLD.
Subject : eretTLEMSS HLLEE Q&L HIEWLPE) ElleNFNII Si(RSHSELD.
@ 11. 6IL&6L ChemEDs E1&HME00T(H 2 6WIT (P(REUMSU|D CHIHOFH(bEHESELD. @

12. ulluiemLuied Type > Indents / Tabs etedTUemss Herfled GFLIWIEYD. (i6DEDEI)
eflemalileemauiled Ctrl + | er6iTLIENS SH(RSHSEULD.

13. eueng tab g 90 mm sienedled ELMBSHFHEYD. leader OLTSHHTemeOTS Herflé AFIIS EUIHLD
uliquwedled YeraflaGamiemL s Gaameshseayn. Weoterns Apply aunssnenensd el
QFIWeLD.

|l
Ltk

imes New Aomen [~ [EEIT[1Z_[=] wo Ho Track [~ ]GWFI=xfn
) | = 3 2 0 =S8 [ ) T
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MYSQL: sreyssensdHed 2 eren 0 7
SL_LemenderfledT LILIedTLIT(h

1. CREATE - ST6YSHSHEMD LOMHMID ASHETT ALTIHLHEMET 2 _(HeunsH&sed (table,
index, views, store procedure, function, and triggers)

2. ALTER - an&eTBeu SHHGID FHT6YHHETHeMS LOMMHMILLIEHLO SHG6D.

3. DROP - FHTYSHSHETHH D 2_6iTan OUMIHeme 55 ESH6D.

4. SELECT- SIEUSSEMTHHED QD HHEUMED HIHLOL 6T(HhSHSED.

5. INSERT - SIemel ([ S Leueneooruied G&Hseb.

6. UPDATE - i Leuemevoruied ermseoTGeu 2 6mem HTemen GLODLI(HSEISH6D

7. DELETE- STEYSHET L 6UHeTTTUIeD 2 _6Tem SIWEVTHEISH 5856608 6METIULD
H&GSSH60.

My sql gl LwiedtLhSS DDL wpmito DML elesorenemens 615U160m&&6d

e FI(pemMm
1. (MYSQL command prompt emw Hmé&s) XAMPP control panel euflwins

2. BIEYSIHNMSHHL 2 _MGHEHemLUI LIWET 6w (user name) MHMID &L 6YFEIFT6D6m DL
(password) LWETLI(bSS 2 6iTIHIMLPSH6D

3. e&npésiulL DDL MysQL eflermeusmeoulement 61&wedLIbSH QeuefuiiemLLl OLm)s.

SYNTAX:

Based on the below syntax queries are built and executed.

* CREATE DATABASE testDB;

* CREATE TABLE table_name (columnldatatype,column2datatype,column3datatype, ....);
* ALTER TABLE ‘table_name' ADD COLUMN "column_name" ‘data_type';

* DROP DATABASE databasename;

*SELECT * FROM TABLE NAME

*INSERT INTO table_name( fieldl, field2,...fieldN ) VALUES ( valuel, value2,...valueN );
* UPDATE table_name SET field1 = new-valuel, field2 = new-value2 [WHERE Clause]

* DROP TABLE table_name ;
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Bimed
CREATE DATABASE SchoolDB;

CREATE TABLE student(
studentID int,
LastName varchar(255),
FirstName varchar(255),
Address varchar(255),
City varchar(255)
);
ALTER TABLE 'members’ ADD COLUMN ‘credit_card_number' VARCHAR(25);
DROP DATABASE SchoolDB
SELECT * FROM student
® INSERT INTO student (studentID ,LastName , FirstName,Address,City ) VALUES ®
(“002”, “Ram”,’Kumar”, “ROJA NAGAR”YCHENNATI”);
SELECT * FROM student
UPDATE student SET LastName = ‘SRI’” WHERE studentID = 003;
SELECT * FROM student
DROP TABLE student ;

SELECT * FROM student

200 gl emm
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Database created

Table created:

studentID LastName FirstName Address City

Table Altered

Database dropped

StudentID LastName FirstName Address City

101 C Priya 1, new street Trichy

202 S Ramu 5, North garden Madurai

St

One row inserted.

StudentID LastName FirstName Address City

101 C Priya 1, new street Trichy

202 S Ramu 5, North garden Madurai

® o ®

002 Ram Kumar ROJA NAGAR CHENNAI
003 R Krishna Park Street Coimbatore
StudentID LastName FirstName Address City

101 C Priya 1, new street Trichy

202 S Ramu 5, North garden Madurai

St

002 Ram Kumar ROJA NAGAR CHENNAI
003 SRI Krishna Park Street Coimbatore
Table dropped.

Table not found.
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0 8 PHP — suqliuemL [Hlired

sigliuewLPHP firemed 2 eunsdl aeuefluilemL Q1LmGHeD.

gl enn
1. Xampp Server (Apache) gl6umni&geD.
2. Goto &l GamiyemméE egeased (Virtual path folder) (c:\xampp\ntdoc)
3. test.php file Gamilemeor 2_(Heunsd, HTemed HLLFF OFUIS.

4. (http://local host/test.php) ereédTm UL L 6med LWEOTU(bSS 2 _rhiseT euemed 2 _someflulled (web
browser)blTeme0 @uissHaLD.

Blred

) <html> @
<body>

<?php

echo “Welcome to Our School”;
$color = “blue”;

echo “My car is “ . $color . «<br>";
echo “My dress is “. SCOLOR . «<br>";
echo “My box is “ . $coLOR . «<br>";

// test whether a number is greater than 30, 20 or 10 using ternary operator
functiontrinary_Test($n){

$r=9$n > 30

¢ “greater than 30”

:($n > 20

? “greater than 20”

:($n >10

? “greater than 10”

202 gl emm
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: “Input a number atleast greater than 10!”));
echo $n” : “$r’\n”;

}

trinary_Test(32);

trinary_Test(21);

trinary_Test(12);

trinary_Test(4);

7>

</body>

</html>

eeueflulcy

Welcome to Our School

My car is blue
My dress is
My box is

32 : greater than 30
21 : greater than 20
12 : greater than 10

4 : Input a number atleast greater than 10!
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10.

11.

12.

13.

14.

Business and Commercial Knowledge,
Foundation course by Board of Studies,
The Institute of Chartered Accountants
of India (ICAl)

Business Management Ethics and
Communication, Study Material, Paper-
Il, Foundation Programme, ICSI.

Principles  of
JJAYASANKAR.

Principles of Management by
KATHIRESEN AND Dr. RADHA

Principles of Management by
P.C.TRIPATHI AND P.N.REDDY

Principles of Management by LM.
PRASAD

Business management
Pagarew

Management by

by Dinkar

Principles  of
J.Jayasankar

management by

Principles of Management by kathiresen
and Dr.Radha

Principles of Management by
P.C.Tripathi and P.N.Reddy.

Principles  of
L.M.Prasad

Principles of Management by Harold
Koontz , Heinz Weihrich and A.
Ramachandra Aryasri.

Management by

Principle of Management — P.N. Gupta
(2005), S. Chand & company Ltd,
New Delhi (First Edition)

Principles of Management, Eighth
Edition — Theory & Franklin (1999)

gl emm
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16.

17.

18.

19.

20.

21.

22.

A.LT.B.S Publishers and Distributors,
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Principles of Management, Tenth Edition
— Harold Koontz, Heinz Weihrich and
A Ramachandra Aryasri (2004), Tata
McGraw - Hill Publishing Company
Limited, New Delhi

Organizational Behaviour — L.M.Prasad
(1993) Sultan Chand & Sons, New
Delhi

Organizational behavior - Stephen
P. Robbins and Timothy A. Judge (
2013) Prentice Hall, USA

Business Management, Fifth Edition -
Dinkar Pagare (1993) Sultan Chand &
Sons, New Delhi

Principles and Practice of Management,
Sixth Edition - LM Prasad (2005)
Sultan Chand & Sons, New Delhi

Stephen P Robbins, "Fundamentals of
Management: Essential Concepts and
Applications", 5th Edition, Pearson
Education., 2005

R.  Sivarethinamohan and P.
Aranganathan, "Principles of
Management", 1st Edition, CBA/Tata
McGraw —Hill Publishing Company Ltd.,
2005.

JamesA F Stoner ,Edward Freeman
and Gilbert, "Management", 6th Edition,
Pearson Education, 1995./ Prentice
Hall of India Pvt. Ltd., 2007.
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Durbin, 'Essentials of Management"
7th Edition, Cengage Learning India
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Albrecht, K. 1980. Brain Power:
Learning to Improve Your Thinking
Skills. New York: Simon and Schuster.

Bourgeois, L.J. lll, and Kathleen M.
Eisenhardt. 1987. Strategic decision
processes in silicon valley: the
anatomy of the living dead. California
Management Review (Fall): 143-145.

Dess, Gregory G. 1987. Consensus on
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performance: competitors in a
fragmented industry. Strategic
Management Journal 8: 259-277.

Drucker, P.E. 1974. Management:
Tasks, Responsibilities, Practices.
New York: Harper and Row : 466-
467.

Eisenhardt, Kathleen M., and Mark J.
Zbarecki. 1992. Strategic decision
making. Strategic Management
Journal 13: 20-22.

Decision Analysis for Managers
(The Quantitative Approaches to
Decision-Making Collection) by David
Charlesworth Business Expert Press
(March 25, 2013)

Business Communication — Radha
Kadhiresan, Prasanna Publication.

Business Communication —
B.Santhanam & Raghunandhan,
Margam Publication.
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1. https://prezi.com/ukyOpOepe5nv/controlling—in-mangment-case-study/

2. https://www.researchgate.net/publication/264971297_A _Case_Study_on_Inventory__
Management_Using_Selective_Control_Techniques

Company Law and Secretarial Practice by Srinivasan.

Company Law and Secretarial Practice by Radha Kathiresan.

http://www.business communication articles.com/types—of-secretary-with-its—definition/
https://en.wikipedia.org/wiki/personal assistant

http://www.inc.com/david.../the—4—kinds—of—personal-assistants—which
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https://study.com/personal assistant.html

206 gl emm

‘ ‘ 12th STD OMS_Tamil version Practicals.indd 206 @ 03-04-2019 14:00:23‘ ‘



GmrGomen

HBI&HS QUMTHemH T HHLD " Gloeomesoremio

ugeueons il gieTem

&eTemm UMMl LSS Gug (S1) LWETLGLSSID Cug

SIT[T600TLD SMIeooTHBHM(b FnMULLLem6EU (1) HMTevor eXlendd SierfleHaUiuL L
Ganlunserr
LT 6U60MSH GLoeometoTemLD ETEDTLIS] LITEUEDITEDT 6Q60TMISHT60T

(60T euT [flemed SHiedr

6(H 2_etoTemio [Flemed (1) gylprhlemed (WedT 6ot [HlemeoGuimch

SDHOFW & Ceauemer, U (S1) THTUMNTMOED GDLIL &8 1qUIH|
@ BewenGuimi e QheoLILEOL, SliqareTm
eTlIaum(Q &I H600TL., GIHIHMHIGTEOLONE
&) DML 6T Fngemevtenwiumn), Guiraummeud&Her
CrrésIhiser HMILOrhISH6T 66UEEUTETMID 2_630T(h
C\&BITET 60 & & 6iT GaM_umbL 60T 6\&MetoTL. Q60&HE
6D L(Lp DM & 6T B euns SseoTemiouded, SiepeuensSHled Heml LNg&s Geuevoriqul
QeI
el Fl st HemL g5 Geuevoriq LieUeoT
Plep&d Hlimed adliasnensdled HLES GuUTelend &HevolléHd
uLegLr aumeunll, aseeerhisener LFHle] OFLEUSHES 6 GSOILILL

SMTOSHH NS

‘ ‘ 12th STD OMS_Tamil version Practicals.indd 207

EITOE o))

207

03-04-2019 14:00:23‘ ‘



208

® [T [ [

2 _Sdl&er Q@ STwnelésiulL Sedbens ML LILIETLI(HEUS.

&IT5H6m 60T GSPIIIL 5558 euensuled aCHEID CIFILIFHED SiDE0E HHEWLFHED

AF ST (W 06UbLEHGSD FMET E\HM60oTL. HLIT

&M QFLIWIILGBL UGS

©_6U0TIT 6L 60T Hlemed Si6vevgd eNYILIL6ToTTEY SILD

1}, &6D (W196)] 6T(bHSH SUWIedN LO6DTHI6m 6D

Beuetnr(h6I6oTEM eflflievorieyL 6o HMID CeuetorbelosTCm Q6TemD C1FILISHED

eXlen&sLb QHEUT GMISS 6X6M5ESH6D 160608 QE0TN GMIHE )| 6TEOT60T SieDEDS)
a5 18 Gunettm ConeormIFIma) eTeoTm) eXlené&SHed

2 _migl & Uetoflemw QsWIDEUNTE QBT ST (LD ST

S(1PSHSLD QKM FLRISGS SiFewns Ssed Apluns sriuLGeuesorgul
(P&AWSG|6UD

BT eumesl wmuTSed (PIEeYHEm6T Thb&SD cHS Hlemed DeriPluiy

15146007 & &l 6ULD LuInd, Ly Siebepg HemL(Ppemmuied ST&SHeLLbD Sirley

QFWELML(h SieWOLL —  EFWEOUTL(H SiemLIL] 6TedTLg S 6Ung)
euensWTerT  FHimieuerr Siemwlun@. @&led [FHimeueotd iy
QFweLN (b UGH&erner 2 pusH Bl Siebevd &hHemSLILI(bS SIS0
S&lwenr sigliuenLuied fmi Gp&senns iflssiul hererg).

auflems SiemoLi

Guendlanifl He1éH@ S(geTen sniBlened 2erflIf&HEDHES NS SNTHEDS
udipsellsHnnT. <k  Hneuer Siemwlifed euflens eugeiled
Gel®he SpeuenT OSTLTEDS

auflems LOMID 2emBluiF

SiemLoLIL

auflems Q&weLTd 2 5506fbEADE WOHMID emfllf QFWEOLIT(H
Aoy pGeonsement WOHMID 2 g6l euprid  HmeuerHHHE
glemevoHhHmsl. siflenflesetr Hnen esE WwHMID Henssener
oanSluifger HlemnmGeunHmISmT sei.

GomHeN[HH&ISHED

QW eunpmefler uUGH WHODI®H UTHET JJeTbISHETeT HCH
—UGSH M SETLOGHSH60

Q&I emM

‘ ‘ 12th STD OMS_Tamil version Practicals.indd 208

@ 03-04-2019 14:00:23‘ ‘



® [T [ [

fimieueoT SiemioLiL]

Blimeuesr &LLemWLUL 6eredtug HMIEUDTHHD HHEUDSHET 6B
Hlemeouled®h gl LHODNH HlemeddHE eTeueuTn] LMLSME 6T60TLmS
Sioneolliug. o1& HoeuensHer eeuaeun Leooll  igeor
QIFWIELLIM(b&ET WMHMID 6THEG MEemns SiefleEs Geuetorhld ereiTLg)
Gurettmeupemm &HevoTLMIADE. Seueusmioli SiemLL EUEDTLLLD
ceold elen&sLLbEDE.

SIeMLOLIL| 6UEMITLILLD

QW HneuarsHler 2 61 slLemwlenl 2 BSCHMIL®b &ML (bD
ULLD Siemoll 6uenTULLD 6TeorlL(blD. Siemiolil] euedIuULLD 6
FIMI6U6DTID 6TENEUTM)] SLL 6WMIDSSBLILIL(bETETE 6TE0TLIENS 6ILIMSHIEUTS
sSTLAILGLSHFHDE. SHfllbUGSE HneuearsHled 2 6ar  LhIE,
eummIL LHMID ASTLILSeneT 2 (HSESHMIL(b ST (bSHMS.

(weoT@eTmig (WeoTeoT OFWHINS (WHEOT(PEMMWINS E\FLIWLLD LI6vof]
auUFHF &SET LTeueons eNeunfHl&H@ED 2 _600TemlD Si6D6DE] 2 _600T6MLOWIEEDTS
BHBHEUDBH6IT
eummliy Ueoofl QFHMLIUNS FLILIGEU6TIT LI SHL 6MLOEHEIT
SHE0TEU | FEmFILITS ereuel® swmfliybleorn) e oreor
®
Q. FwFle &levoriq LIy

sieTeneus Gl Srrevollaer iemelih OFLWS Fnlquienel (6T.5T) Fn6dl euUhIEWIS).

LI600TL &M ThS SHMIT600f&H6iT

9 6001y L (B FnlqUl HMT600fISHET HDHEWIT

SHTMLEH

2_evoremiouiement Sirlediwied (pemmuled Spuie) EFILISHED.

FLL(pemm STLOMEOTRISET

SNIEW &med HMID HevorLsmed S Lrkisefleir SHeoeme.

SLL6m&SSLILLL
SITLOM60T Rl ST

eTLIOLIM(Q&ID Si6d60d SlHUSHIOL B HlspeyseT

QBMTETEm&HS SITLOMEOTHRIGH6IT

Guwebrflemen GLoeOMeTOTEMLOWINED 6T(b&SLILIbEME.

SLGUUGSSHID STTevoflse6T

STLONe0TD QFILGHEmED FH(hHGLD &HITT600f|HET

a6y SHmedT FMIHS
6T 600T600TLD

eTH D)6 LSHIITed erpLbld SbhSHemeot

‘ ‘ 12th STD OMS_Tamil version Practicals.indd 209

EITOE o))

209

@ 03-04-2019 14:00:23‘ ‘



B [ ® H .  EEEm

6([H Ml 60 6001 S5H6D oung QesdHener  SiewLeUdsHHETS LOGam —FHewmserfled
CHM&sm&HemeT 2 _sHhHeH HSSHDGI.

5 &IemLPLIL| Q5HHIEMIPLIL| eTeOTUS QI Ug 2_miifereng sinlwsaliuobsgid Gung)
GuettflanssLLbHDS).
LTeloLTD ugevLTD eredtugl Semoliied wuevoflyflud uesoflwimermy serflemL Gui

2 _6Tem @DHMIemeNW GSBGHMDE

Gun gl HHed 6 SiemIoLIL] HTedT SiemL W Ceustor@wi Be0&HS LHMID SM&EsHmemen
SMLEUSNS efleslunbd LuIHd &L

BuwsGse SlpueooflnenT &@bh&H@ EUPTRIBLILI(LD S46em600T MM INT6YEWIT & EmeTs
SH&SADE

6E0TH e ETTTHS 6UEDlEmLD 8@ uetflullement QsLEUSNS, g 6TeoTeor Levofl ermBs Q&leug),
erliGung asleug wni &l GUrSDTS6T eTeiTLSHEN60T &n M6EUS).

SiFlenT LILIEmLE) Guediflemed UetOlWNENTHET FHhlBHEHHE 6BHM(bSHHLILULL S ST
wHOID  eurmliysener Shser &  uelyflueuisEnsE
MO SHSBHEUSHTSLD.
® ®
Gumunieneu Gupuniemel 6reiTLg SHEWEDEUT WOMID 660TN| HDDOFH BSOS

GuoulL mpuflL 2 eTer HlewLUTEGLD. @FH60T cpeod Lievoflulleneor
HEveD (WewDUled QLG (WIg&HS SWIEDE.

Delegation(Geuemen HBMIHMS 506G Sp H60T SHLLewaNLILlg 65 Geuemen
urkiserfliiy (1) Geuemen e&wwbLIg. LesoflwimemflLb UILENLLILGS H@&LD. MeUBID SibG
u&liey) FlsMIHems enml Levollemil (1968 QULDLLILGE HHESLD.
Devolution Guedwl L sien@sefled Smha S0 L JDGHEHHES AHSHTTHmSD
(9 asnoiudiey) wrprlwefliu@s eredrm| snmeriD.

Deconcentration &b Fleo Letfleemear WSHHII () bled SiTssafledr (pa&eurflLid,

QUUEDL S8 fmbs (weopuled (pussslieuneus. 5 Gume
uevoflaem Beuemed LiEHemeU &emmLUILSDELD, Heded HITeuns
eeueflium igH@&o eveurm| OFWWILILGLEDS.

Decentralization 8% FWeLITLIqe0T e6edD HMID HL 6L SHED&HSHEMEN (PSHILILDTS
(UTEUETHGSHD () FILLLObBED, (PI66bSESH, GuneiTm Letofleemen Lifls&is
MLOWILILI(b SHSTEmLD) QBMGbLILG De0g (WA iFlany uGHule Qumha Sphleneouled

o _eremeuiseflLid Siefllig.

210 gl emm

‘ ‘ 12th STD OMS_Tamil version Practicals.indd 210 @ 03-04-2019 14:00:23‘ ‘



eFsLIfliuen

0560 E\FTELE0IED E\FLLIGDITEITT

NN

uempw Crmonesflwss Cuomdled agwieonenfleor GeuemeosHemen QFLILID

a1l snifl

SIYI6UEDS CIFUIEOITEIT

3iYI6UEDS GeUEMEVSHET, HLL &8, 1BTeneoGLAUTed LiFleverflliLig) LoHMID
Fnl L 6(QMIG eFLSH Gurerm Geuemed QFWILD HLIT

6fib LLHMID Fepsd
euUITMILIL|S6iT

seoflwmy esweoneny ey auTMILIL&emeT eulliLieuT

Bl& sLemL&HET

LI6DOTLD, 6Urhid] &60015E, OUMISHSITIL IO b, eurfl 2erdluib
GuEdTHEUMHEMM EMBIITETEUS] (LHEOTETBET (LHEO(hHET, U(HLOMEDT eurfl
goriliug), smiSsh 6O\&MeTHEHHBTE0T LIGOOID 61FQISHESIHE0

seofl ©_gelwimerny

(waeomerfl QFeLAID BEUEmED&ET LMHMID EUPSHSHLONEDT EeUEmEDSHEmaT
QFLILIeT.

T SHSHHLOMM SIemLOLIL]

6U6DOfl&HD Si6b6ONS [HIMI6UEDTD EOMLILLMMM HIMIEU6DTLD, SieEDE| EOMLILOMHM
SiemLoLIL]

&L (bD6YF SThIGHLD

QLINHEMTSITT, FCPS LOHM)] HeonsNT CHEMEUSEMEN &hSHléHde SIS
Ganiha Heoteormd &rhlsbLD

SMSI5HNS

SHTSH SVIEUDHD 600G GIGUIBLIL SHl&mf]

QSMHIMSThISHLD

eflwmuny ShisSSHET 6(QMHISGEDDSESLILL. CUTHHS Fnl LD

‘ ‘ 12th STD OMS_Tamil version Practicals.indd 211

EITOE o))

211

03-04-2019 14:00:23‘ ‘



esMPIH&Heel —siqliLenL leTetoreml aLmmluiiuied
Gedrflemeo IevoTLMD 4600T(h

mreondflwiiser wHmID GLoedMILIEUTETT &6l

sevel 9GeonesT & eUELIHIT

wevareus GILITEOT. GLOMT

Benevor WsGeoTT (UMLSSILLID )

wflend sevelufuied Spmiigdl wHmib LuinHe HmieueoTd ,
Qls6iTemenT — 600 006

LIML[BITEd 6UEDEVIBIT SH6iT

(weeraui &. 1QMedl6f] Tmevof]
2_sei GuondfwiT wHmID Hlewn SeneveuT
B asweorfliied gemn

@rrevofl Guoml sedberil (SedTevrmial)
61g6iTemenT — 600004

LIML. (k15 6m6TOTLILIMEITT &6
(WemeuTeuT 1. Qenrhl@&HmevenT,

(tomBleo mebeondAflwiy efl(pg—2018)

2_gel Guordflwir

e sebeflufiied SyrmitEd) wHmib LuIHE HimieueTd
61860160607

IJIT.LDGDD.'QS“@, ul gl gy Aflui,
wnbled sevelufied pomitéd wnHmibd LuinHd Himieuerd

615 60Tem 60T

6B RISl em6ToTLIL
T@welq (wevflemsl

‘ ‘ 12th STD OMS_Tamil version Practicals.indd 212

UL mred Syl sei
weoara.d.CreniaEnCeHal

2 gefl Guundflwiy

sebeflufluled giemmn

SIEOTEWETT QBT EN &ET LEDSEWES SHLPSLD

C1BTEMLSSHITETED.

U. &S WIHMITTUIEo0T60T,
glemevor GuomAfwiy
euetoflsefluled glewn

8.8 emeuetoteus seoeifl.

IBOUTSSID, O1F6iTeneT — 600106.

61g2.amedT ST mevofl
glemevor Gumdrfwit

Bnuio asweorflied glewm
F(BSsmsed BT sHeoaufl.

C\FEDEUITILIED, E1FEITEm60T — 51.

&.6\6urmkIsBL&60T

glemevor GurmAfluiy

cuetollsaiiLied glemm

19.6T610. HATMILETOTEML Hemed WHMID Sinflexlieh sedgurfl
BTEUEITH, 6\&6iTemenT — 600 130.

US5& 61lq6emLOLIL|
2 ConsEAWID QLedsHen
1F60T60I60T.

SHLLEST
P. &MOML& @ememueILIHLOmeT
2@end MM, OF6TEneT — 600083,

68.semenFe1Fevadl
Srmuymid, 61&eiTemenT — 600013,

QR Team
Br. OR&HTHE0T, QoL Hlevew A,
sanrmi &) el HbHlemeoliLeer,

&@evoraLyTid, GUITEaIBIT , & (H6LETUTETTTTLO 6D ED.

w.@@@m&a’m uL gl gy Aflwif,
sarmi &l vt HbHlemeoliLeer,
QLSS BeueTmesoT BH ML &ID,

WHHNBUL DL, H(Heur el

&5 SHEOLITL. GUETEUEDT LIMLY, L L gl apdfiwi,
airdleor 2_wifflemeoLiLererl, ALBLOmeT Gameed,

LI&@LY, TMobISUTLD

@pmred 80 gerev.erd. eredleetor GolidlEGsm  smarfled
SFFLOUL beTang). SHlI6EL. (emmuied SiFd.GLmT:

03-04-2019

14:00:23 ‘ ‘



SMILy &6l

‘ ‘ 12th STD OMS_Tamil version Practicals.indd 213 @ 03-04-2019 14:00:23‘ ‘



‘ ‘ 12th STD OMS_Tamil version Practicals.indd 214 @ 03-04-2019 14:00:23‘ ‘



SMILy &6l

‘ ‘ 12th STD OMS_Tamil version Practicals.indd 215 @ 03-04-2019 14:00:23‘ ‘



‘ ‘ 12th STD OMS_Tamil version Practicals.indd 216 @ 03-04-2019 14:00:23‘ ‘



	1_12th STD OMS_Tamil version FM
	12th STD OMS_Tamil version Chapter01
	12th STD OMS_Tamil version Chapter02
	12th STD OMS_Tamil version Chapter03
	12th STD OMS_Tamil version Chapter04
	12th STD OMS_Tamil version Chapter05
	12th STD OMS_Tamil version Chapter06
	12th STD OMS_Tamil version Chapter07
	12th STD OMS_Tamil version Chapter08
	12th STD OMS_Tamil version Chapter09
	12th STD OMS_Tamil version Chapter10
	12th STD OMS_Tamil version Practicals

